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Note: Images in this presentation may be slightly different from production as 

the configurator is continually updated to reflect new features and product 

selections. 
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1. Lenovo disclaimer 

x-config diplays a disclaimer when first launching, with the following text: 

This tool is designed as an aid only and is distributed on periodic basis. 

Please verify all configurations with trained Technical Personnel. The data 

contained in this tool is distributed AS IS without certification. The use of the 

data is for information and planning purposes only, and does not constitute a 

representation or warranty by Lenovo regarding the verification results. 
 

 

 

The user has the option of selecting the language for the user interface from 

this screen. Options include:  

 Chinese (Simplified) 

 Chinese (Traditional) 

 English 

 French 

 German 

 Italian 

 Japanese 

 Korean 

 Spanish 
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2. Getting Started 

If using the System x and Cluster Solutions Configurator (x-config) for the 

first time, this section will show you how to install the program and begin 

building a new solution. Throughout this guide a solution could be an 

iDataPlex, Intelligent Cluster, Microsoft Cluster, NeXtScale, or other 

Integrated Solutions available under Express => No-option solutions => Type 

=> Template. Ensure that “Intelligent Cluster” is selected on the x-config 

Starter screen. 

 

2.1. Online Install / Update x-config via the following URL ­  

https://www.ibm.com/products/hardware/configurator/americas/bhui/asit/ 

 

Note: x-config requires Oracle SDN JRE Version 6 or higher that can be 

obtained at the following URL: Oracle SDN Java SE Runtime Environment 6  

 

https://www.ibm.com/products/hardware/configurator/americas/bhui/asit/
http://www.oracle.com/technetwork/java/javasebusiness/downloads/java-archive-downloads-javase6-419409.html#jdk-6u14-oth-JPR
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2.2. Starter Screen 

When starting the application the following screen will appear and present 

different ways to begin working on a new or existing solution. At any time 

after entering the configuration mode, the user may return to this screen by 

selecting the Starter option from the File menu. (Note: As indicated via a 

warning message, exiting a configuration by returning to the Starter screen 

will destroy any unsaved changes in the solution currently being created or 

modified.)

 
 

a) Express – Quickly create a simple solution with limited options 

b) Custom – Create a new solution from scratch 

c) Open – Load a previously saved solution 

d) Help – Get help with basic functions within the tool 

e) Exit – Close x-config 
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3. Express Configuration 

Selecting Express will allow you to quickly configure a solution with limited 

options.  

 
3.1 Example: View of the iDataPlex Express configuration screen 

An iDataPlex solution allows for 2 – 84 nodes (in pairs). You can also 

create a Solution using either an iDataPlex integrated rack, Standalone 

chassis with iDataPlex rail kits, or Standalone chassis with Enterprise 

rail kits. 
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3.2 Example of an iDataPlex solution using Express configuration  

 

 
 

 

 After selecting your choices on the Express Solution 

Configuration screen you will be prompted to save the 

configuration file (.cse). 

 This will also create the TMF .cfr and TMF .xls files. 

 SOVA will automatically be invoked to verify the 

configuration. 

 The resulting file name contains ‘Customer name_date/time 

stamp’, and will be preceded with ‘CS’ for Custom Solution. 
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3.3. Express => No-option solutions => Type => Template 

To create integrated solutions that are not listed in the Solution pick list, 

select “No-option solutions”. The Type picklist will display high level 

configuration options, and the Template picklist will display options for 

starting points for the selected configuration type. Using a template will 

create a solution with server, storage, networks, and other such options 

already defined. 
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4. Creating / Modifying a Solution 

The solution configuration interface appears after creating a new solution or 

opening an existing one. From this screen, the user can fully customize nearly 

every aspect of a solution. In the following example the iDataPlex solution 

was created via the Express mode. 

 

 
 

 As items are added, modified, or removed, the networking and 

racking rules will automatically be applied and x-config will 

dynamically insert the appropriate number of switches, select the 

required length of cabling, and select the appropriate power 

supplies and rack power distribution. The lower right of the 

screen shows current Messages. Additionally, a cluster Summary 

will display statistics about the current state of the entire cluster. 

At any point, the user can revert to a previous state of the cluster 

from the History tab and view actions previously performed on 

the cluster. 
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4.1. Cluster Level Rack Actions 

 
 

 All current racks are shown on the Rack List on the left side of 

the screen. 
 

 To create a new rack, click on the Add New Rack selection at top 

of rack list. 

 

 To show this rack in the inspection widow, right-click on the rack 

and select Inspect Rack. 

 

 To change rack options, such as options, label, or label color 

identifier, right-click on the rack and select Change Rack 

Options. 
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 To update the quantity of a rack, right-click on the rack and select 

Update Rack Quantity. 
 

 To duplicate a rack into a new rack using the same options and 

filled with the same items, right-click on the rack and select 

Duplicate Rack. 
 

 To remove a rack, right-click on the rack and select Remove 

Rack. 
 

 Some of the above actions are also available at the top of the Rack 

View/Update for the rack currently shown in the center of the 

screen, as shown in the image below. 

 

 
 

 
4.2. Item Level Rack Actions 

 

 All current and available items display in the Item List on the left 

side of the screen. 
 

 Left-clicking on a rack from the Racks List will bring the item 

into the Rack View, where the user can manually place, edit, or 

delete any item in that rack. 

 

 Highlighting an item will show its details in the Item View on the 

right side of the screen. The Item View also shows network lines 

visually indicating network connections, and an action menu for 

that item shown in the order: Edit, Duplicate, Remove 
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Edit | Duplicate | Remove 

 
 

 To create a new item, highlight over an open slot in a Rack and 

click the blue Add button. This will open a pick list where the 

user may choose an item and then fully customize the item. After 

clicking Save to create the new item, the user may either create a 

single instance of the item, fill the entire rack with the item, or 

enter a specific quantity of the item to place into the cluster. 
 

 To modify an existing item, highlight the item and either press 

Edit (the Notepad with a pencil) that appears directly on the 

item, or right-click on the item and select Edit Item from the 

menu.  

 

 To duplicate an existing item, highlight the item and either press 

Duplicate (an arrow pointing down to the right), or right-click on 

the item and select Duplicate Item from the menu.  

 

 To remove an existing item, highlight the item and either click 

Remove (the Trashcan) that appears directly on the item, or 

right-click on the item and select Remove Item from the menu. 

 

 To move an item, click and drag the item to the desired location. 

If bumped against another item which can be moved to an 

adjacent slot, the item in the way will automatically move to that 

adjacent slot. Some items will also show blue or red boxes to the 

right side of some slots to indicate preferred or restricted slots, 

respectively.  
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4.3. Item Creation/Modification 

When a new item is created, or an item is being modified, x-config 

displays the following options: 

 

 Network connections can be configured 

 

 Main, Expansion, Required, and/or Blade options may be 

selected 

 

 Basic VLH items can be added Item label and color may be 

changed 

 

 Base item type may be changed (only when creating a new item) 

 

 

Adding or removing network connections will dynamically alter the 

available options on an item, and will automatically install or 

remove the appropriate hardware required for the selected networks. 

If the item has no way to connect to the network, it will 

automatically drop the network selection.   
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Creating a new item will present the following levels of insertion: 

 Single – Create a single copy of the new item 

 Pick – Pick selected spaces for this item 

 Rack – Fill the entire rack with as many copies of the new item as 

possible 

 Quantity – Create an exact number of copies of the new item into 

the cluster 

 

Saving an edited item will allow the following levels of modifications: 

 Global – Modify all copies of this item 

 Rack – Modify all copies of this item for the current rack only 

 Multi – Modify multiple copies of this item based on user 

selection 

 Single – Modify a single copy of this item 

 Cancel – Cancel all modifications 

 

Removing an item will present the following levels of removal: 

 Single – Remove a single copy of the item 

 Multi – Remove multiple copies of the item based on user 

selection 

 Rack – Remove all copies of the item from the current rack 

 Global – Remove all copies of the item from the entire cluster 

 

Note: When saving an item in any way other than globally, a new 

“template” or “version” of the item will be created, and any modified 

settings will only apply to the selected template or version. Any 

previous versions of the item outside the scope of the modification 

will remain unchanged. This will be reflected by a different label 

name and label color given to the new item. 
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5. Cluster Preferences 

To open the Cluster Preferences, select Cluster Preferences from 

the Preferences menu selection. 

 

 

 

 

5.1. Networks 

Adding, changing, and removing networks and their settings are 

available under the Data Networks tab. The color button box next to the 

network type selection is the cable color for that network. Clicking on 

the button will provide a choice of more than one possible color 

selection for that particular network's cabling. 

 
 

5.2. Power, Services, and Software 

Select the desired option in these tabs to change the cluster Power type 

selection, cluster level services, and software. 
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5.3 Expert Review Checklist 

Answer the checklist questions carefully so the Solution center and 

reviewers have all the pertinent information on the customers Solution 

requirement. This information is mandatory in most configurations. 

This information will also help to architect the solution and to 

troubleshoot the configuration as designed.  

 

 

6. Solution Rules 

Important note: Solution rules are important for successfully configuring 

solutions, and therefore should always be left on. If advanced users need to 

disable rules, as should only be done when the automation processes are not 

sufficient to meet the specific needs of the cluster, then the advanced user may 

choose to disable the automatic networking or racking rules. x-config displays 

the options to disable/enable the rules in the Rules menu. 

 

 Disabling networking rules will prevent the solution from dynamically 

adjusting any switches, adapters, servers, and cabling. 
 

 Disabling racking rules may prevent the solution from enforcing certain 

rules designed to keep all items in the cluster in accordance with 

Intelligent Cluster and racking standards. 
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7. Cabling 

To view cabling, select Cabling Preferences from the Preferences menu. All 

cables are automatically selected based on network cable color and length 

required to make the connection from source to destination.  
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8. User View Options 

There are a few options available to the user under the View menu to simplify 

the cluster building experience: 
 

 Rack View Size – Extra Small, Small, Medium, and Large are 

available. These are automatically selected based on the user's system 

screen display size settings. In the order specified above, the 

recommended display requirements are 1024x768, 1280x1024, 

1600x1200, respectively. 

 

 Rack List Orientation – Ability to set Rack view either as upright or 

toppled over if you change the default from Show Rack Icons off to 

Show Rack Icons on.  

 

 Part Numbers – Shows or hides TMF and/or HVEC part number 

information with item descriptions.  

 

 Show Color Labels – Toggles the display of the item color labels to the 

left of each item in the middle Rack View area. 

 

 Show Network Lines – Toggles the display of item network 

connections for the highlighted item. Lines to another item in the same 

rack indicate a connection to that item, whereas a line inside the circle 

on the highlighted item indicates a connection to an item outside the 

rack. 

 

 Show Images – Toggles the display of actual image pictures on top of 

each item. Disabling this may increase the performance for some 

computers. 

 

 Show Allocation – Toggles the display of the rack allocation gradient 

to the right of each item in the middle Rack View area. According to the 

weight distribution of the item, a lighter shade of green indicates a 

lighter weight allocation. 
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9. Tutorial 

This section is a quick step­by­step to the creation of a simple cluster from 

scratch to get the user acquainted with the interface. 

 

a. Start by creating a new cluster from scratch by selecting Custom from 

the Starter screen, with “Intelligent Cluster” selected. Choose Intelligent 

Cluster. Choose the appropriate Country and Region. Choose ‘Full 

catalog – also include general racking components for special bids’. 

Choose the desired Rack power settings. Lastly choose Finish. 

b. In the first automatically created rack, highlight over any slot and press 

the blue Add button. Select Server, then New Server from the menu. 

c. In the Item View section, type in a different label name for this item in 

the field next to Item Label, choose appropriate Node role, then click 

Change color below the label field and choose any color for the new 

item. 

d. Select a server type from the box next to Base Item. 

e. Check the box next to Compute (Ethernet) under the Networks tab 

section, to give this item a Compute server connection. 

f. Make some changes to the option under the Standard features and 

services and Expansion Options sections. 

g. Click Save, and select the first option, which indicates that only a single 

item will be placed in the current rack. 

h. Highlight over another empty slot and press the blue Add button. Select 

Server, this time you should see the item which was previously created 

listed in the menu above the New Server button. Click the previously 

created item from the Server menu, and select the third option, which 

indicates that the current rack will be filled with as many of this item as 

it can hold without affecting other items in the rack or creating a new 

rack. 

i. Open the Cluster Preferences screen from the Preferences menu choice. 

j. Change the Management Network at the top to Distributed using the 

radio button. 

k. Click Add Network at the top of this panel and type in a name for the 

new network.  

l. Click Save, then click OK. 

m. Some items may have been moved to other racks to account for the new 

leaf switch that was created. If so, remove the extra rack by right-
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clicking on it from the Rack List on the left of the screen and clicking 

Remove Rack. 

n. Edit one of the servers created earlier by right-clicking the item and 

selecting Edit Item from the menu. 

o. Select the newly created network for connection to this server in the 

Networks tab section. 

p. Change a few of the options under Standard features and services. 

q. Click Save, and select the first button to indicate making the changes to 

all instances of the item. 

r. Create a new rack by clicking on Add new rack from the Rack List. 

s. Add the previously created item by clicking the blue Add button again, 

this time selecting the fourth option on the dialog that appears, 

indicating a specific quantity of the item to be added. Enter any amount, 

and then click OK. Try 100, 1000, or even 10,000. Note: some systems 

may take a long time to draw and perform cabling for more than a few 

hundred racks. 

t. Save the cluster by clicking Save from within the File menu. 

u. Now you have completed a cluster configuration of at least 100 servers. 

Enjoy! 
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100 Node Intelligent Cluster  
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10. Help and Support 

The x-config: Help and Support page provides a variety of information 

on separate tabs: 

 Release notes: Links to x-config enhancements, updated 

weekly and the current limitations/workarounds list 

 Education: Detailed training for configurations using any of 

the three configuration types displayed on the Starter page: 

Intelligent Cluster, General Purpose, and PureFlex System 

 FAQ: Frequently asked questions 

 Help contacts: Configuration support information and 

specific instructions to report problems 

 

 

https://www.ibm.com/products/hardware/configurator/americas/bhui/asit/help.html

